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Use this guide for your first steps with the Agilent 6400 Series Triple Quad 
LC/MS, and as a road map for your user information.

What is the Agilent 6400 Series Triple Quad LC/MS system?

The Agilent Triple Quad LC/MS is a liquid chromatograph triple 
quadrupole mass spectrometer that performs MS/MS using three 
sets of parallel rods (in this case, quadrupole, hexapole, 
quadrupole). The first quadrupole separates ions into precursor 
ions that are fragmented in the hexapole into product ions, 
which are separated by the second quadrupole. Often, two or 
more precursor ions and their product ions are monitored in 
sequence in MRM (multiple reaction monitoring) mode. You can 
monitor up to 4000 MRM transitions by using Dynamic MRM.

The Agilent 6460 Triple Quad LC/MS is shipped by default with 
the Agilent Jet Stream Technology. This technology utilizes a 
super- heated sheath gas to collimate the nebulizer spray which 
dramatically increases the number of ions that enter the mass 
spectrometer.
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What’s New in Data Acquisition
You can set up an Agilent Triple Quad LC/MS with either the Agilent 1100LC 
or 1200 LC modules.

Also, the Agilent Triple Quad LC/MS comes with Agilent MassHunter 
Workstation Software that includes three major programs:

• Data Acquisition – From one screen you can tune the mass spectrometer, 
control and monitor instrument parameters, set up acquisition methods and 
worklists containing multiple samples and monitor real- time run plots.

• Quantitative Analysis – From one screen you can set up a batch of data 
files and quantify, evaluate and requantify the results. From this screen you 
have access to the Method Editor for setting up and editing the quantitation 
methods.

• Qualitative Analysis – From one screen you can extract and integrate 
chromatograms, subtract background, extract peak spectra, and compare 
data from different types of data files.

What’s New in Data Acquisition

B.03.01 SP1

• Compliance capability is supported for Study Manager and related utilities.

• Installation and Operational Qualification (IQ/OQ) is supported.

B.03.01

• The Study Manager program is supported. You can create a study from a 
worklist or from a PK LIMS input file.

• You can update a dynamic MRM method using a data file or a Quantitative 
Analysis report results.

• You can view a dynamic MRM method in the Dynamic MRM Viewer window.

• The Map File Generator program is supported. This program allows you to 
modify a map file which is used to map columns in an import file to the 
column names in a worklist.

• The Agilent 1290 Infinity high performance Auto Sampler (G4226A) is 
supported.

• The Agilent 1290 Infinity Binary Pump (G4220A) is supported.

• The Agilent 1290 Infinity DAD (G4212A) is supported.

• The Agilent 1290 Infinity TCC (G1316C) is supported.

• Capillary voltage can be changed during a run for HPLC- Chip Cube 
systems.
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What’s New in Data Acquisition
B.02.01 with Service Pack 1

• The Agilent 1290 Infinity high performance Auto Sampler (G4226A) is 
supported.

• The Agilent 1290 Infinity Binary Pump (G4220A) is supported.

• The Agilent 1290 Infinity DAD (G4212A) is supported.

• The Agilent 1290 Infinity TCC (G1316C) is supported.

• Peak width information is shown in Dynamic MRM user interface.

• The Dynamic MRM phase II database is supported.

B.02.01

• The Agilent 6410A Triple Quadrupole LC/MS is supported.

• The Agilent 6410A 2K Triple Quadrupole LC/MS is supported.

• The Agilent 6410B Triple Quadrupole LC/MS is supported.

• The Agilent 6430A Triple Quadrupole LC/MS is supported.

• The Agilent 6460A Triple Quadrupole LC/MS is supported.

• The mass range is 5 to 2250 amu for the Agilent 6430 Triple Quadrupole 
LC/MS.

• The Agilent 6460A Triple Quadrupole LC/MS is still supported (see below).

• Dynamic MRM is supported. Dynamic MRM allows you to add up to 4000 
transitions in a single time segment with up to 200 transitions overlapping 
at a time.

• Version B.02.00 with Patch 3 of the Agilent MassHunter Workstation 
Software -  Qualitative Analysis program is supported.

• Version B.03.01 of the Agilent MassHunter Workstation Software -  
Quantitative Analysis program is supported.

• Fast polarity switching with 30 ms polarity switching time is supported for 
the 6430A and 6460A.

• Fast polarity switching with 500 ms polarity switching time is supported 
for the 6410B.

• When acquiring data on the 6410B, 6430A, or 6460A, no correction to the 
baseline for dark current or electronic noise is done. Thus, this noise is 
included in the data file.
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What’s New in Data Acquisition
B.02.00

• Only the 6460A Triple Quadrupole is supported on this revision.

• The Agilent Jet Stream Technology is supported on the Agilent 6460 Triple 
Quadrupole LC/MS.

• The mass range is extended to 5 to 3000 amu for the Agilent 6460 Triple 
Quadrupole LC/MS. No tune masses are above 2600 amu.

• The mass range is 5 to 1650 for the Agilent 6410A Triple Quadrupole. 
The mass range is 5 to 2000 for the Agilent 6410B Triple Quadrupole.

• You can acquire up to 500 MRMs per time segment.

• You can acquire more than 150 MRMs per second.

• Fast positive/negative polarity switching is supported (100 ms switching 
delay).

• Agilent VWD Models D and E are supported.

• Gradient Delay Reduction is supported on the HPLC- Chip.

• The Agilent 1367D high performance Autosampler SL Plus is supported.

• Any language can be used to create scripts.

• A worklist can be inserted into the current worklist.

• A custom icon is used to indicate a MassHunter data file. The “.d Icon 
Changer” program is available to change the icon for data files that are 
already acquired.

• Logbook notifications can be displayed in the taskbar in the form of balloon 
messages.

• The amount of free disk space is displayed in the status bar of the Data 
Acquisition window.

• DA Reprocessing program is available to allow reprocessing of data files 
using the Qualitative Analysis program.

For information on what is new in the Qualitative Analysis and Quantitative 
Analysis programs, refer to the Familiarization Guide for each of these 
programs.
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Where to find information
Help
Where to find information 

Help

Press F1 To get more information about a pane, window or dialog box, place 
the cursor on the part of the pane, window or dialog box of interest and press 
F1. 

Help menu From the Help menu, access “How- to” help and reference help. 

Documents

You can find these manuals delivered with the Triple Quad hardware or 
software. You can also find a PDF version on the installation disk, in the 
Manuals folder.

Installation Guide This guide is used to install the hardware and software, 
configure the instrument, and verify performance.

Concepts Guide - The Big Picture Learn the background information to help 
you understand operation of the hardware and software.

Maintenance Guide Use this guide to help maintain and troubleshoot your 
Agilent Triple Quad LC/MS.

Data Acquisition for 6400 Series Triple Quad Familiarization Guide Do the 
exercises to learn to use the Triple Quad LC/MS hardware and Data 
Acquisition program for 6400 Series Triple Quad.

Study Manager Quick Start Guide Use this guide to learn to use the 
MassHunter Study Manager software.

MassHunter Optimizer Software Quick Start Guide Use this guide to learn about 
the MassHunter Optimizer program. The MassHunter Optimizer program 
provides a way to automatically optimize the data acquisition parameters for 
MRM mode (multiple- reaction monitoring) on a Triple Quad instrument for 
each individual compound analyzed. (This guide is on the MassHunter 
Optimizer disk.)
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Where to find information
Training
MassHunter QQQ Compliance Quick Start Guide Use this guide to learn about 
the MassHunter QQQ Compliance program.

MassHunter Quant Compliance Quick Start Guide Use this guide to learn about 
the MassHunter Quant Compliance program. (This guide is on the 
Quantitative Analysis disk.)

Qualitative Analysis Familiarization Guide Do the exercises to learn to use the 
Qualitative Analysis program. (This guide is on the Qualitative Analysis disk.)

Quantitative Analysis Familiarization Guide Do the exercises to learn to use the 
Quantitative Analysis program. (This guide is on the Quantitative Analysis 
disk.)

Training

Familiarization Guide Use all three familiarization guides to get to know the 
software.

Quick Start Guide Use the quick start guides for Study Manager, Optimizer 
and Compliance to get to know these programs.

Training Courses Visit www.chem.agilent.com to view a listing of training 
courses for the Agilent Triple Quad LC/MS.
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Getting Started
Getting Started

Install the Triple Quadrupole LC/MS hardware and software

Use the Installation Guide to install the hardware and software and verify 
performance. 

Set up, run and analyze samples

The roadmap below shows you the steps to set up and run a batch of samples 
from start to finish. Follow the instructions on the next pages to get started 
and to learn where to find the information to help you with each step in this 
roadmap.

Start 
Here!

Set up, run 
and analyze 

samples

3 Set up and 
run an 
acquisition 
method

1 Start the 
Data 
Acquisition 
software

2 Prepare the 
LC/MS

4 Review results 
with 
Qualitative 
Analysis 

5 Set up and run 
quantitation
Agilent 6400 Series Triple Quad LC/MS Q
uick Start Guide
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Getting Started
Step 1. Start the Data Acquisition software
Step 1. Start the Data Acquisition software

The instructions below include the following assumptions:

• The hardware and software are installed.

• The instrument is configured.

Use instructions in the Installation Guide to configure the instrument for 
the first time and any time you change the LC configuration.

The LC modules and the Triple Quad MS are turned on, but the LC pump is 
not running.

After installation, you see all of the Agilent MassHunter Workstation Software 
icons on your Desktop.To start the Data Acquisition program, double- click the 
Data Acquisition icon.

The Data Acquisition window appears.

NOTE When Data Acquisition opens, the software engines automatically 
start. If for any reason, they are stopped and you need to restart 
them, double-click the Acq System Launcher icon on your Desktop, 
and click Start.

If you have recently changed LC modules, remember to configure the 
instrument again. See the Installation Guide for instructions.
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Getting Started
Step 1. Start the Data Acquisition software
Four panes—where you do most of your work

When you first start the Data Acquisition program, the main window appears. 
You do almost all of your work within the five panes of this main window. 
These panes provide the tools to set up acquisition methods, run samples 
interactively or automatically, monitor instrument status, monitor runs and 
tune the instrument.

Figure 1 Main window of the Data Acquisition software component

Click a button to 
see the pane you Instrument Status pane Real-time Plot pane Method Editor Worklist pane
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Getting Started
Step 1. Start the Data Acquisition software
Show/hide the panes You can show one pane at a time on the screen or up 
to four panes. You can never hide all four panes. To show or hide a pane, you 
click the icons in the main window toolbar or you use the commands in the 
View menu.

When you click on a pane, the active pane is outlined in blue. Press F1 to 
obtain help on the active pane. You can also drag a pane border to resize the 
pane.

Instrument Status pane You may have several different LC modules in your 
LC stack, for example, both a well- plate sampler and micro well- plate sampler. 
With this pane you can make sure that the correct LC module is configured. 

You also set non- method control and configuration parameters for the LC 
devices and MS device and monitor the status of the device parameters during 
a run.

Real-time Plot pane With this pane you monitor the chromatogram and 
spectral plots in real time.

S–Instrument Status; R–Real-time Plot
M–Method Editor; W–Worklist; T-Tune
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Getting Started
Step 1. Start the Data Acquisition software
Method Editor pane  With this pane you enter instrument settings for 
acquisition methods and sample information to run individual samples 
interactively.

Worklist pane With this pane you enter sample information for individual 
samples and information for worklist samples. When you run the worklist, the 
samples are automatically run in the order listed in the worklist.
Agilent 6400 Series Triple Quad LC/MS Quick Start Guide 11



Getting Started
Step 2. Prepare the LC modules
Step 2. Prepare the LC modules

Read and follow the instructions in the online Help for each of the tasks in 
the checklist described on the following pages.

1 Switch LC stream to Waste.

While you condition or equilibrate the column, you can tune the Triple Quad 
MS. During this time you do not want pump effluent streaming into the Triple 
Quad MS, so you switch the direction of the LC stream away from the MS ion 
source and to waste.

If you have the LC connected to a VWD or DAD, you can still monitor the 
fluctuations of the VWD or DAD real- time chromatogram before a run.

a Right- click the MS QQQ device in the Instrument Status pane.

b Click LC > Waste.
2 Purge the LC pump.

Follow the directions for purging the pump in the User Guide for your 
pump.
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Getting Started
Step 2. Prepare the LC modules
3 Set up to condition or equilibrate the column.
a Type LC parameters, and click Apply to download them to the LC.

b Right- click an LC module in the Instrument Status pane to change any 
non- method control parameters, if necessary.

c Monitor the baseline and adjust the plot to make sure the column is 
equilibrated and the baseline stable. (See step 4 and step 5 on 
page 14.)
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Getting Started
Step 2. Prepare the LC modules
4 Set up to view real- time parameter values (actuals).

As you prepare for a run and during a run, you want to see the actual 
values of the instrument parameters. You can do this in the Instrument 
Status pane.
a Right- click the Actuals list to see the Setup command.

b Click Setup to bring up the list of Actuals available for monitoring.

c Add all the parameter values you intend to monitor, and click OK.
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Getting Started
Step 2. Prepare the LC modules
5 Set up real- time plot displays.

As you condition the column, you set up the displays to monitor the 
effluent.

• Right- click the chromatogram plot, and click Change.

In the Edit Signal Plot dialog box, you can select the type of display signal.
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Getting Started
Step 3. Prepare the Triple Quad instrument
Step 3. Prepare the Triple Quad instrument

Do a Checktune, Autotune or Manual Tune

1 From the Context list, click Tune.

You can see the Instrument Status pane, the Real- time Plot pane and the 
Tune pane when you switch to the Tune context. Click the Tune icon in the 
toolbar if the Tune pane is not visible.

2 Click Checktune to evaluate if the MS parameters are within the limits to 
produce the specified mass accuracy and resolution (2 to 5 minutes).

Do a Checktune regularly.

If Checktune passes, then skip to the next section, “Switch LC stream to 
MS” on page 17.

If Checktune fails, then you need to do an Autotune, which is described 
next.

3 Click Autotune to tune the MS automatically (15 to 20 minutes). The 
system automatically changes different tune parameters to tune the MS. You 
only do an Autotune when it is necessary.

You only mark the Start from Factory Defaults check box after an 
instrument shutdown and restart. Then, if you click Autotune, the 
instrument is tuned starting from the factory defaults (20 to 25 minutes).
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Getting Started
Step 3. Prepare the Triple Quad instrument
A report is automatically generated after Autotune completes successfully. 
If Autotune fails, no report is printed.

If Autotune fails or you assess that the Agilent Triple Quadrupole MS needs 
custom values entered for its tune parameters, you can also do a Manual 
Tune.

4 From the Context list, click Acquisition.

Switch LC stream to MS

• After you condition the column and tune the Triple Quad MS, you switch 
the LC stream from Waste to MS. See “Switch LC stream to Waste.” on 
page 12 for how to do this.
Agilent 6400 Series Triple Quad LC/MS Quick Start Guide 17



Getting Started
Step 3. Prepare the Triple Quad instrument
Monitor MS baseline and spectral displays

If you did not monitor the LC baseline with a VWD or DAD, make sure that 
the Triple Quadrupole baseline is stable and no spectra of interfering intensity 
appear in the display.

If you did monitor the LC baseline with a VWD or DAD, change back to the 
default Triple Quad displays.

1 Right- click the chromatogram plot, and click Change.
2 Select the MS signal, and click OK.

View the system logbook for events and errors

As you prepare the instrument, you may run into an error that you want to 
troubleshoot. You do this through the System Logbook Viewer.

• Click Tools > System Logbook Viewer or click the  button in the 
toolbar of the Data Acquisition window, and view the logged events. You 
can also enable automatic notification when an error or warning occurs. 
Right- click the  button in the Quick Start tray and click Configure. If 
notification is not enabled, you also need to right- click the  button and 
click Enable Notification.
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Getting Started
Step 4. Set up and run an acquisition method
Step 4. Set up and run an acquisition method

Read and follow the instructions in the online Help for each of the tasks 
described on the following pages.

Also, do Exercise 1 of the Data Acquisition for 6410 Familiarization Guide to 
learn how to set up and run an acquisition method. The parameters to use if 
you have installed an inlet that uses the Agilent Jet Stream Technology can be 
found at the back of this manual.

1 Set up the method:
a Type the values and settings for each of the tabs below.

b (optional) If you want to download the settings to the instrument, click 
Apply.

c To save the method, click File > Save As > Method.

d Name the method and click OK.
2 Enter values for all of the LC modules configured for the instrument.

NOTE Make sure when you type the MS parameters on the next page that the tune file is the one 
that you want to use with the acquisition.
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Getting Started
Step 4. Set up and run an acquisition method
3 Enter Triple Quad MS parameter values.
a Select the Scan Type from the list.

The parameters available on the right change depending on the Scan 
Type.

b Type in any Acquisition values you want to change. You can enter 
multiple Scan segments.

4 Set up to change Triple Quad MS parameters with segments and scans:
a To add a segment, right- click anywhere in the Scan segments section to 

bring up the Scan Segments menu, and click Add Row.

b Type the parameters for each Scan segment.

5 Set up signals for the real- time plot:
a Click the Chromatogram tab.

b Select the Chromatogram Type, and type other plot values.
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Getting Started
Step 4. Set up and run an acquisition method
6 Set up and run interactive samples:
a Type the sample name, data file name and pathway, and method name.

b To start the run, click the single sample button, .

You can run the single sample in either locked or unlocked mode. When the 
mode is locked, no one can change the method or sample parameters.
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Getting Started
Step 4. Set up and run an acquisition method
7 Set up and run worklists 
a Right- click the upper left corner of the worklist.

b Click Add Multiple Samples.

c Type all relevant information, and click OK.

d To set up the worklist run, right- click the upper left corner, and click 
Worklist Run Parameters.

e Type the paths for the method and data files, and click the tab to 
specify the sample vial locations (make sure the specific sample tray 
type has been configured by right- clicking the autosampler device 
image).

f Specify the locations, and click OK.

g To start the run, click the Run Worklist button, .

You can run the worklist in either locked or unlocked mode. When the 
mode is locked, no one can change the method or the worklist while the 
worklist is running.
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Getting Started
Step 5. Review results with the Qualitative Analysis program
Step 5. Review results with the Qualitative Analysis program

• Use the Qualitative Analysis program to do these tasks and more:

• Review results for acquisition method development

• Select the most appropriate precursor and product ions for MRM 
analyses

• Find compounds

• Identify compounds

• Do molecular feature extraction

Do the exercises in the Qualitative Analysis Familiarization Guide to help 
you learn how to use the Qualitative Analysis program.

Do Exercise 1 of the Data Acquisition for Triple Quad Familiarization Guide 
to help you learn how to use the Qualitative Analysis program to develop 
acquisition methods.

Step 6. Set up and run quantitation

The primary tool for analyzing and reporting Triple Quad LC/MS results is the 
Quantitative Analysis program. 

• Do the exercises in the Quantitative Analysis Familiarization Guide to 
learn how to do these operations to quantitate the acquired data files:

• Set up a batch and a method to automatically quantitate a set of 
samples

• Review results by learning how to view and use the Batch- at- a- Glance 
results screen

• Identify and use outliers to change the method and requantitate the data 
using a better calibration curve fit or other more appropriate settings

Also, refer to online Help to learn how to do more operations to analyze your 
data.
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In this book

This book contains brief 
instructions to help you get 
started with your Agilent 
Triple Quad LC/MS. This book 
takes a quick look at using 
the Data Acquisition program 
to:

• Prepare the instrument for 
a run.

• Set up acquisition methods.

• Set up and run worklists.

If you have comments about 
this guide, please send an 
e- mail to 
feedback_lcms@agilent.com.

mailto:feedback_lcms@agilent.com
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